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Chapter 1 ● Introduction 

Description 
 
The ecom i.roc x10 -Ex PDA is based on Windows Mobile™ and has an Intel® Xscale™ 
PXA255 400 MHz processor, an integrated WLAN 802.11b, Bluetooth™, and an IrDA 
infrared port. It has RAM 64 MB SDRAM (55 MB available), ROM 32 MB Flash-ROM, 
and 2.8 MB iPAQ File Store (NVRAM) memory. The i.roc x10 -Ex is available in three 
different versions: ecom i.roc 610-EX (Intrinsically-Safe PDA), ecom i.roc 510-EX (Non 
Incindive PDA), and ecom i.roc 410-EX (Ruggedized PDA). Features include a light, 
ergonomic, and ruggedized design, high-resolution color display, protection from static 
electricity, water, and dust, a non-corroding shockproof housing, and an internal antenna. 
The keyboard has an On/Off switch, reset key, 5 programmable quick access keys, and a 
5-way navigation field.  

See: http://www.ecomus-ex.com/us/intrinsically_safe_products/data_processing/pda_i/ 
 

Pictures 
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Chapter 1 ● Introduction 

Accessories 
The following accessories are available for use with the ecom i.roc x10 -Ex PDA: 
 
• Leather case with belt holder and strap (A0002777) 
• Hand loop (A0002778) 
• USB data transmission set (A0002779) 
• Barcode Imager BC x 10 -EX (A0002768) 
• RFID-Module RF x10 -EX (A0002767) 

Setup Requirements 
Installation of PowerNet Twin Client requires, at a minimum, the following: 
 

• A Pentium-class processor 
• 32 MB of RAM 
• 10 MB of free hard disk space available 
• Microsoft® Windows Mobile operating system 

Synchronization Tools 
At least version 3.1 of ActiveSync is required for desktop synchronization and 
communication. ActiveSync is freely downloadable from the Microsoft® web site  
at http://www.microsoft.com/windowsmobile/downloads/default.mspx.  
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Chapter 2 ● Terminal Setup 

Downloading from the WEB 
The PowerNet Twin Client software package can be downloaded from the Connect web 
site at http://www.connectrf.com. Click on Partner Services and then click on Software 
Downloads. Select the file named PowerNet Twin Client for ecom. 

Running Setup from a Download File 
The downloaded file is a compressed archive. After extraction using a utility such as 
WinZip or PKWARE, folders are created on the hard disk as shown in the following 
figure. 

 

Click on the Disk1 folder to view the files as shown in the following figure. 

 

Click on the Setup application and proceed to the following section entitled Installation 
for further instructions. 
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Terminal Setup 

Installation 
The InstallShield wizard runs and presents the following screen. 

 
Click on Next to begin the installation process. 

 
To change the default Destination Location, click on Browse and select a location. Then 
click on Next. 
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The default folder is PowerNet. This default may be changed either by selecting an 
existing program group or by typing in a new name at the prompt. Then click on Next. 

 
When the installation is complete, reboot the system to initialize the Twin Client 
software. 

a. To reboot the system immediately, click on Finish. 

b. To reboot later, click on the option to restart the computer later, and click on Finish. 
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Running the Manager 
The PowerNet Twin Client Manager is the utility that manages the terminal software and 
configurations. 

Select Start, Programs, PowerNet, and Twin Client Manager.  The PowerNet Twin 
Client Manager screen appears as shown in the following figure. This is the 
administrator's main screen, and all functions are accessed from its menu bar, toolbar, 
and tabs. 

Menu Bar 
The menu bar provides access to the functions used to configure the terminals and 
manage their software.  

 

Toolbar 
Found under the menu bar, the toolbar provides shortcuts to major features. The toolbar 
can be turned on or off by changing the Toolbar parameter found on the View menu. The 
shortcuts available from the toolbar are as follows: 

 Create a new terminal configuration. 

 Open an existing terminal configuration. 

 Save the current terminal configuration. 

 Download the configuration to the terminal. 

 Download software to the terminal. 

 Configure terminals automatically over the wireless network. 

 View the PowerNet Twin Client Manager version. 

The PowerNet Twin Client Manager is now successfully installed and ready for use.  
The next section provides detailed instructions for quickly configuring the terminal  
and starting a Telnet session. 
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Quick Start 
This section describes how to prepare the Twin Client Manager and the ecom terminal for 
a Telnet session with the host. Following an initial serial download, the terminal software 
and configuration are managed automatically over the wireless network. 

Note:  The ecom terminals are normally delivered with ecom files pre-installed. 
However, if the terminal does not have those files installed, refer to instructions  
at the end of the Software Management section before proceeding. 

Configuring the Manager 
The first step is to configure the Twin Client Manager to meet site-specific requirements, 
and then prepare it for the automatic management of the terminal software and IP 
addresses. This simple procedure will require only a few minutes to complete. 

Setting the Emulation 

Click on Start, Programs, PowerNet, and Twin Client Manager. Select the Settings 
menu as shown below. 
 

 

Click on Emulation, select the desired emulation, and click on OK. 
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Setting the Servers 

The Servers are the Telnet host systems the terminals will access. 
 

 

To set these addresses from the Settings menu, click on Servers and then click on Add. 
Enter the name of each server, its IP Address and IP Port (normally 23 for Telnet 
servers), and emulation type. Then click on OK. 

 

Repeat this step for each Telnet server the terminals are required to access. If an error is 
made in the name, IP Address, IP Port number, or Terminal emulation type, click on the 
line that is in error, and then click on the Edit button to make the corrections. Use the 
Load button if you want to load an .svr file. Use the Save As button if you want to save 
your file as an .svr file. 

Setting Terminal Operations 
 
Select Terminal Operation from under Settings in Twin Client Manager. 
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The option of Run Airloader on terminal can be selected and the Airloader server IP 
address can be entered.  The Windows CE options of Run application at startup and 
Hide task bar can be selected. Also, there is a CE option Use GUI menus and screens 
that makes the terminal program act more "Windows-like".  

The Code page setting determines the Windows font code page that will be used on the 
terminal. The default is zero, which means that the terminal will use the standard Unicode 
code page. This option is necessary to turn on character sets for foreign languages. 

For more information on code pages, see the document entitled “Code Pages” at 
http://www.connectrf.com/faq.htm. 
 

 
 

Click on OK after entering information. 

Setting Terminal Model 

Under Settings, click on the Options menu as shown. 
 

 

Select a terminal model, radio type, and COM port assignment. 
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Saving the Configuration 

Click on File and Save As. Enter a name for this configuration. 
 

 

For the purposes of this example, the name is vt220. 
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Setting Airloader Auto-Configuration 

The configuration download and IP address assignment for each terminal will take place 
automatically by setting the Airloader Auto-Configuration options. 
 

 

Click on the Airloader option in the Tools menu. 

Note:  If the Airloader Auto-Configuration window does not display the options, click on 
the Advanced<< button. 

If multiple network adapters are installed on the PC, ensure that the desired network 
adapter is selected. The adapter selection can be changed by clicking on the Change 
button. 
 

 

This powerful software management tool is described in detail in Airloader Auto-
Configuration. For now, it is sufficient simply to use it for assignment of the initial 
terminal configuration and IP address, both of which can be easily changed later. Ensure 
that all of the check boxes are checked as shown above. 

To assign terminal IP addresses automatically over the wireless network, check all of the 
boxes as shown above. Then click on the Addresses button and enter the desired range 
in the From and To boxes as shown in the following figure. 
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After setting the address range, click on OK to return to the Airloader Auto-Configuration 
screen and then click on the box next to Terminal/Group Manager. 
 

 

The display expands to show the default terminal group. Next, click on the New Group 
icon and use the Browse button to select the configuration file saved earlier. 
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Check the Active box, and the system is now configured to automatically download IP 
addresses, software, and configuration files to the terminals. Click on the  box in the 
upper right corner to return to the main menu. 

Note:  The software does not need to be authorized now. It can be authorized later, after a 
Telnet session has been established. The procedure is described in the section 
entitled Authorizing PowerNet. 

Supported Equipment Manual   •    May, 2006  2-11  



Terminal Setup 

Configuring the Terminal for Download 
The terminal download requires a serial connection between the terminal and the PC 
through a cable. In preparation for this download, connect the cable to the selected serial 
port on the PC and to the terminal. 

On the PC, click on Start, Programs, PowerNet, and Twin Client Manager.  Under the 
Terminal menu, choose Send Program Files to Terminal, as shown in the following 
screen.  

 

The following screen is displayed. 

 

Choose Yes at the prompt. The following screen is displayed. 

 

Click on OK. 

The PC is now configured to download to the terminal. 

Booting the Terminal 
 
To perform a boot, press the Reset keys (those closest to the screen).  
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Troubleshooting 
 

Error Indication Possible Cause Corrective Action 
No AirLoad Manager 
Found 

AirLoad Manager not 
active, or not installed 
on the LAN segment 

Ensure that PC with Twin Client 
Manager is on same segment and that 
PC is operating. If PC is not on same 
segment, enter address of PC in 
response to the terminal prompt. 

Manager not Active Previously identified 
AirLoad Manager is no 
longer found. 

Same as above. 

After taking the corrective action, the terminal must be booted.  A successful wireless 
connection and download is indicated by the display of the Twin Client main menu 
shown below. 
 

Twin Client 
© 1991-2006, Connect, Inc. 
 
Keypress To Continue 

Note: The date of 2006 is updated on the terminal at the time of a new release. 

The terminal is now ready to establish a Telnet session with the host system. 

Standard Setup 
The default terminal setup is sufficient for most installations. However, to meet site-
specific requirements, it may be necessary to customize terminal operation. The standard 
setup options simplify this process and can be modified by the following methods: 
• Using the Twin Client Manager. 
• Using the Twin Client terminal menu system. 

This section describes how to use the Twin Client Manager and the terminal menu 
systems to set up the terminal. Also described are the methods for authorizing the 
terminal software. 

Setup Using Twin Client Manager 
The Twin Client Manager provides a Standard Settings tab for automatic setup of the 
terminals. Choose Standard under the View menu. The options within this tab vary 
according to the emulation selected, each of which is described below. 

VT Settings 

Select the VT emulation setup by clicking on the Settings menu and then the Emulation 
menu, as shown below. 
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Then click on the vt100 or vt220 selection, as shown below. 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for VT emulation. 

 

2-14  Supported Equipment Manual   •    May, 2006 



  Terminal Setup 

Quadrant Mode 

This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   

Font  

The Font Size scroll box allows you to choose the font size and the Bold Font check box 
enables (checked) or disables (unchecked) the display of characters in bold font. 

Key Click 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal, provided that the manufacturer supports the control of terminal key click sound. 
The default value is on (checked). 

Printer Type 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 

5250 Settings 

Select the 5250 emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below. 

 

Then click on the 5250 selection, as shown below. 
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Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 5250 emulation. 

 

Quadrant Mode 

This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  
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 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   

Font  
 
The Font Size scroll box allows you to choose the font size and the Bold Font check box 
enables (checked) or disables (unchecked) the display of characters in bold font. 

Key Click 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal, provided that the manufacturer supports the control of terminal key click sound. 
The default value is on (checked). 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 

3270 Settings 

Select the 3270 emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below. 

 

Then click on the 3270 selection, as shown below. 
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Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 3270 emulation. 

 

Quadrant Mode 

This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   

Font 
 

The Font Size scroll box allows you to choose the font size and the Bold Font check box 
enables (checked) or disables (unchecked) the display of characters in bold font. 
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Key Click 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal, provided that the manufacturer supports the control of terminal key click sound. 
The default value is on (checked). 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 
 

Terminal Setup Using Twin Client Menus 
The Twin Client terminal software provides an internal menu system for configuring 
parameters on the terminal and switching between Server and Telnet mode.  To get to the 
Twin Client main menu from the startup screen shown below, press uppercase C.  
 

Twin Client 
© 1991-2006, Connect, Inc. 
 
Keypress to Continue 

 
In thick (Telnet) mode, the following menu appears: 
  
Edit Server/Host IPs 
Edit License Key 
Switch Client Modes 
Run Client Emulator 
Exit to OS 
  
In thin (Server) mode, the following menu appears: 
  
Edit Server/Host IPs 
Run Site Survey 
Switch Client Modes 
Run Client Emulator 
Exit to OS 

Use the Up arrow and Down arrow keys to navigate the menu, and press Enter to select 
the highlighted option. Each menu option is described below. 

Edit Server/Host IPs 

If the host IP address(es) were not pre-configured as described in the Setting the Servers 
section of Configuring the Manager, or if you wish to change those settings using the 
terminal menus, select this option and enter up to four Host IP addresses as required. 
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     Host 0 
IP 206.183.67.155 
Port 23__ 
 
<F3> Save <F7> Quit 

Press F3 to save the configurations. 

Edit License Key 

The client software can be authorized automatically, as described in the next section, 
Authorizing PowerNet. This menu option permits authorization of each terminal 
manually. Select this option to obtain the terminal's Identification Code, which is used to 
obtain the Authorization code from the Connect web site, as described in the next section. 

The 12-digit value displayed at the top of the terminal screen is the Identification Code 
for the terminal. 
 

00A0F826E614 
Authorization 
    ______________ 
 
not authorized 
 
<F3> Save <F7> Quit 

Type the Authorization code into the field as it appears on the web site. Punctuation 
characters, such as the hyphen (-), are required. Press F3 to save the Authorization code. 

Run Site Survey 

This option (a feature of Spectrum 1) is applicable to Release 5.0 and may be obsolete for 
your terminal. 

Switch Client Modes 

The PowerNet Twin Client normally operates in Telnet mode, which provides direct 
connection to Telnet hosts. It can also operate in Server mode, through a PowerNet 
OpenAir server. Select this menu option to switch between Server and Telnet modes of 
operation. Note that the host socket address for the PowerNet OpenAir servers is 1800, 
which must also be changed in the Edit Server/Host IPs menu described above. 

Run Client Emulator 

After all desired changes have been made, select this option to return to the Twin Client 
main menu. Then press any key to establish the Telnet session and begin emulation.  
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Authorizing PowerNet 
 
Each PowerNet Twin Client will run for 30 minutes at a time without authorization.  
Uninterrupted operation for a production environment is the result of authorizing the 
software.  

The Twin Client Manager can automatically authorize the terminal over the wireless 
network if the following requirements are met: 
• A PC running Twin Client Manager is connected to the wire LAN segment with at 

least one access point within range of the terminal. 
• The System ID of the PC on which Twin Client Manager is installed has been used to 

obtain a site license Authorization code from the Connect web site. 

To obtain the System ID of the Twin Client Manager, click on the Authorization option 
in the Tools menu, as shown below. 
 

 

The Authorization window is displayed as shown below. 
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Your System ID appears in the first box of the screen.  
 

Go to http://www.connectrf.com. Click on Partner Services. Click on the Generate 
Authorization icon at the top of the page. Follow the directions on the web site. 

Authorized Terminals 

The number of terminals authorized, terminals in use, and terminals remaining are 
provided in the Authorized Terminals box on the lower left side of the screen. 

Click on the Details button to number the options in the screen below in the order of your 
priority. 

Note: The terminal may or may not be able to utilize the Formatter feature depending on 
its Authorization codes. 

 

Click on an option and move it using the Up and Down buttons.  

Click on OK when finished. 

The Manual Authorization button is an alternate method of obtaining an Authorization 
code for a terminal. This method does not utilize Airloader, as does the other method. 

Click on this button, manually enter your MAC address in the screen that appears, and 
click on OK. This enables you to generate individual Authorization codes. 
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Adding Licenses 

The Add Licenses feature is used when adding additional licenses to an already site 
licensed Twin Client Manager. (i.e. Twin Client Manager is licensed for 10, and the 
customer purchases another 10 licenses to make a total of 20.)   

From Twin Client Manager, choose Authorization from under the Tools menu. Click on 
the Add Licenses button.  

 

A pop-up box appears with the Machine ID and a space for the additional license’s 
Authorization code.  Enter the additional license’s Authorization code and click on OK. 

Use the Machine ID in the pop-up box instead of the original Machine ID to get your 
Authorization code.   

If adding users, click on the Add Licenses button before generating the Authorization 
code to get the most current Machine ID. 
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Transferring Authorization 
 
The Transfer Licenses feature is used when moving a site license from one PC to 
another.  After Twin Client Manager is installed on a new PC, you will need the 
System/Machine ID for it.  This ID appears in the first box of the Authorization screen. 
 
From Twin Client Manager, select Authorization from under the Tools menu. 

 
Click on the Transfer Authorization button on the old PC. You will be asked for the new 
System ID.  Enter this new System ID.  It will generate an Authorization code for the 
new PC's Twin Client Manager.   

 

 
 

Note: This feature only works if there are licenses remaining on the old PC.   
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Listing 

Click on the Listing button to view Authorization codes used along with corresponding 
serial numbers. 

 
 
Click on OK when finished. 

Click on the Close button when finished. 
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Software Management 
In addition to providing functions for the download of files to the terminal via the 
traditional serial connection, the Twin Client Manager also provides for the management 
of terminal software and configurations automatically over the wireless network. 

Software Management describes the automated capability in detail. Additional manual 
operations involving serial download options are described at the end of this section. 

Airloader Auto-Configuration 
The Airloader Auto-Configuration form is accessed from the Twin Client Manager Tools 
menu. Select Airloader. 

 
Note: If no options are displayed, click on the Advanced<< button. 

Enabling Automatic Downloads 

Click to put a check in the box that allows terminals to be automatically configured via 
RF to enable automatic downloading. In the event that another PC on the network is 
already configured and active, the following warning message is displayed. 
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Synchronizing Configuration Files 

Click to put a check in the Synchronize Configuration Files box to enable automatic 
synchronization of configuration files on the terminal. When the terminal is booted, its 
configuration files will be compared with the most recent on the PC. The terminal is 
updated automatically if it does not have the latest revision. 

Synchronizing Program Files 

Click to put a check in the Synchronize Program Files box to enable automatic 
synchronization of program files on the terminal. When the terminal is booted, its 
program files will be compared with the most recent on the PC. The terminal is updated 
automatically if it does not have the latest revision. 

Automatic IP Address Assignment 

An IP address does not need to be assigned to the terminal. The ecom i.roc x10 -Ex 
terminal will find the Airloader server automatically.  

Creating New Groups 

New groups, with different configurations, can be created by clicking on 
Terminal/Group Manager and then clicking the right mouse button as shown. 

 

After the new group has been created, the group settings option becomes available for 
change, as shown below. 
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After the Configuration File and all of the other parameters have been set, the group is 
made active by clicking on the Active check box. 
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Clicking on the Thin Mode button will cause all terminals in this group that are currently 
running in thick mode to be switched to thin mode the next time Airloader is run on the 
terminal. 
 
Click on the Schedule button to view a dialog box for scheduling an automatic Airloader 
update. 

 

 
 

Select the desired time and click on OK. Click on Update Now and the Airloader “push” 
capability controls terminals from this end. 
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Setting the Segment 

Checking the Segment button restricts a terminal group to a range of IP addresses. The 
IP Address can be any valid address on the segment, as it is used only to identify the 
segment. The setting of the Net Mask can be used to restrict the range.  This feature is 
useful for segregating terminal groups by location. 

Setting Force Reload 

Clicking on the Force Reload button forces all terminals within a group to be 
automatically updated. The following warning message appears. 

 

Click on the Yes button to force the reload. 

Setting the Default Terminal Group 

New terminals that have not yet been assigned to any group are initially assigned to the 
default group in effect when they are booted. 

 

Any group can be made the default group by clicking on the group, and then clicking on 
the right mouse button. Then click on the Make Default option. 

Reassigning Terminals 

After a terminal has been configured and assigned to the default group, it can be 
reassigned to a new group by clicking on the terminal icon as shown below. 

 

Then, holding the mouse button down, drag the terminal icon to the desired group. 
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Release the mouse button, which reassigns the terminal. 

 

The next time the terminal is rebooted, it will be reconfigured as defined in the group 
specification. 

Mobile Device Manager (MDM) Features 
 
Under Tools in Twin Client Manager are the Screen Watcher, Terminal Messenger, and 
RF Monitor features. 

Note: The terminal may or may not be able to utilize the Screen Watcher or Terminal 
Messenger features depending on its Authorization codes.  

 
 

Select Screen Watcher, enter the terminal’s IP address, and click on OK. 
 

 
 

A screen will appear with a display resembling the terminal screen. 
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Clicking on the Font button on the upper left brings up a screen in which you can modify 
the font settings, as shown below. 

 

 
 
Select Terminal Messenger from the Tools menu.  
 
You may enter an Address Range in the From and To boxes on this screen. Click on Add 
when finished. 
 
Enter a message to send in the space provided, select the terminal to receive this message 
by clicking on it in the Select Terminal(s) column, and click on the Send button to send 
the message of your choice to the terminal of your choice. 
 
See the example of the Terminal Messenger screen below. 
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To remove a terminal from the list of terminals receiving your message, click on the 
terminal number in the Select Terminal(s) column, and click on the Remove button. 
Click on the appropriate button, Remove All, Select All, or Unselect All, to remove all 
terminals, select all terminals, or unselect all terminals from the Select Terminal(s) list. 
 
Note: Use the Ctrl and Shift keys to select multiple terminals. 
 
Click on the Close button when finished. 
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Select RF Monitor from the Tools menu. 
 

 
 

RF Monitor is an "Over The Air" diagnostic tool. It is used to collect diagnostic trace 
information from RF terminals running PowerNet Twin Client software. 

It runs on a Windows PC and will send a command to the RF terminal to start tracing. 
The terminal, when it receives this command, will start sending the trace information 
over the RF link to the PC that issued the command. This will be written to a file on this 
PC that can be sent to us for analysis. 

Click on File to Select Terminal or to Exit. 

 

Choosing Select Terminal allows you to view a log of the terminal’s activity. Enter the 
Terminal IP address and Terminal IP Port, and click on OK.  
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Click on Edit. Select Find and/or Find Next to search for pieces of information in your 
log, or select Clear to clear the search. 

 

Click on Actions to select Start Monitor or Stop Monitor. 

 

Click on Tools to choose Set Debug Levels or Settings. 

 

The options in Set Debug Levels are shown below. 

Supported Equipment Manual   •    May, 2006  2-35  



Terminal Setup 

 

The maximum log file size can be set under Settings. 

 

Click on View to show or hide the Toolbar and the Status Bar.  

 

This is the Toolbar. It is found near the top of the screen. 

 

This is the Status Bar. It is found at the bottom of the screen. 

 

Click on About RF Monitor under Help to view version number information. Click on  
About Twin Client Manager under Help in the main menu to view the following screen. 
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RF Monitor is a very small program and does not even require installation. Just place it in 
a directory on your PC and create a shortcut to run it. It will run on all versions of 
Windows except V3.1 and Windows 95.  

 
1. Move RF Monitor to a Windows PC with Network access to the RF terminal. 
 
2. Run RF Monitor. (Create a shortcut or do a Start/Run.) 
 
3. From the pull down menu, select File/Select Terminal. 
 
4. Key in the RF terminal IP address and leave the port at 1802. 

 

 
 
5. From the pull down menu, select Tools/Set Debug Levels. Set all levels to 9 except 

Datastream and SNA. 
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6. With the RF terminal sitting at the Press Any Key prompt, select Actions/Start 
Monitor. 

 
7. Press a key on the RF terminal to open a session, and you should see trace data in the 

RF Monitor window. When done, end the trace and the file will be named 
tnxxx.yyy.log (where xxx.yyy is the last 2 octets of the RF terminal’s IP address) in 
the directory in which RF Monitor was running. 
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Common Problems with RF Monitor 
 

• The trace won’t start.  

RF Monitor uses UDP to send commands to the RF device. On busy networks, UDP 
packets are not always delivered. The terminal can miss the command to start the 
trace. Below are some things that can be useful. 
 
a.   Ping the RF terminal from the PC used before starting RF Monitor. (This seems 

to "open" a path to the terminal.) 

b.   Start the Monitor with the terminal at the Press Any Key prompt. (While the 
terminal is at this prompt, it is not doing much and has a better chance of hearing 
the start trace command.) 

 
• I don't understand what this trace means. 

 
The trace that this tool collects is engineering-level information. It allows an end user 
to collect information that can be analyzed by Connect engineering. 
 
It will generally be requested by Connect support to help diagnose a reported 
problem. 
 
To be able to read and understand these completely, you need to have an 
understanding of: 
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a. Emulation protocols (IBM 5250, IBM 3270, DEC VT200, etc.) 
b. PowerNet Twin Client products 
c. RF Network concepts 
d. Wired network concepts 
e. Telnet sessions 
f.  TCP/IP  

 

They are text files that can be read with any editor or viewer and can be useful to end 
users and integrators, even if they may not have all the requirements above. 
 

• I have an intermittent problem and it could happen on any one of my 100 
terminals. RF Monitor only does one terminal at a time. What can I do? 
 
RF Monitor is not the right diagnostic tool for this type of problem. PowerNet 
products have another diagnostic tool that can be used called the "Diagnostic Server".  
 
This tool can be set up to run trace diagnostics on up to 300 terminals at the same 
time. This tool will be provided as needed for systems under PowerNet support 
agreement OR by T&M when they are not covered. 

It also includes the service of a PowerNet support engineer. 
 

Server Transfer is another feature. From the Tools menu, select Server Transfer. 

 
The FTP Settings screen appears. 
 

 
 
To send object editor and configuration files from Windows to your Linux box, enter 
your server address, and click on OK. 
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Sending Program and Configuration Files to the 
Terminal        

                   
1.   Boot the terminal.  

2.   On the PC, select Send Program Files to Terminal from the Terminal menu in Twin 
Client Manager. 

 

The following screen will appear. 

 

 
   3.  Click on OK. 

The following screen will appear. 

 

 
4.   Click on OK. 

 
5.  On the PC, choose Send Configuration Files to Terminal from the Terminal menu 

in Twin Client Manager. 
 

 
 

You will see the following screen. 
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6.   Choose Yes. 
 

 
 

7.   Click on OK. 
 

The following screen will appear. 
 

 
 
 

8. Click on OK. 
 

9. Boot the terminal. 
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Under Terminal, you may select Receive File from Terminal. 
 

 
 

Enter the path and file name to receive from the terminal in the Upload File dialog box. 
 

 
 

The default file is “rf.log”. Click on OK. 
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Chapter 3 ● Keypad Configuration 

Diagram 
 

 

-reset button 

     OK

    reset button- 

  F5 

        F2                 

F1 
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Table 
 
  
Key VT 3270 5250 
▲ <▲> <▲> <▲> 
▼ <▼> <▼> <▼> 
◄ <◄> <◄> <◄> 
► <►> <►> <►> 
Reset <Reset> <Reset> <Reset> 
OK <OK> <OK> <OK> 
F1 <F1> <F1> <F1> 
F2 <F2> <F2> <F2> 
F3 <F3> <F3> <F3> 
F4 <F4> <F4> <F4> 
F5 <F5> <F5> <F5> 
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Chapter 4 ● Error Message Resolution Guide 
Twin Client Error Message Resolution Guide 

 
Message Reason Solution Reference Tech Note 

ENTRY TOO LONG; Trying to key beyond the field size. Ensure that you are entering input into 
the correct field. 

--- 

ALPHABETIC ONLY; Trying to key a character that is not 
alphabetic. 

Ensure that you are entering input into 
the correct field. 

--- 

MINUS NOT VALID; Trying to key a Minus sign. Ensure that you are entering input into 
the correct field. 

--- 

DECIMAL NOT VALID; Trying to key a Decimal (period). Ensure that you are entering input into 
the correct field. 

--- 

ALPHANUMERIC ONLY; Trying to key characters other than 
Alphabetic and numeric. 

Ensure that you are entering input into 
the correct field. 

--- 

NUMERIC ONLY; Trying to key characters other than 
numeric. 

Ensure that you are entering input into 
the correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into 
the correct field. 

--- 
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Message Reason Solution Reference Tech Note 
    

   

   

INVALID KEY; The key pressed is not valid. Ensure that you are entering input into 
the correct field. 

--- 

MUST CLEAR FIELD; Trying to enter data in a field that 
must be cleared first. 

Ensure that you are entering input into 
the correct field. 

--- 

SCAN NOT ALLOWED; Trying to scan into a key only field. Ensure that you are entering input into 
the correct field. 

--- 

KEY NOT ALLOWED; Trying to key into a scan only field. Ensure that you are entering input into 
the correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into 
the correct field. 

--- 

RECOVERABLE ERROR; Encountered an error from which 
you can continue. 

Verify that your configuration settings 
for the hardware being used, usually a 
printer and cable issue. 

--- 

UNRECOVERABLE ERROR; Encountered an error from which 
you can NOT continue. 

Verify that your Network settings are 
correct and you are in the correct 
mode using the correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

FUNCTION: \n\nFILE: \nLINE: \nCODE; Encountered an error from which 
you can NOT continue. 

Notify Connect over the WEB incident 
reporting system. 

--- 

Press any key\nFor More Details...; Press Enter for more information. Advisory message. ---

Press any key; Press a key to continue. Advisory message. ---
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Message Reason Solution Reference Tech Note 
    

Connection ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Connect. Verify that your Network settings are 
correct and you are in the correct 
mode using the correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Disconnect ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Disconnect. Verify that your Network settings are 
correct and you are in the correct 
mode using the correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Send ERROR.\nREBOOT MOBILE 
UNIT; 

Could not Send. Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Receive ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Receive. Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Check ERROR.\nREBOOT 
MOBILE UNIT; 

Could not run the RF Survey. Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Timeout ERROR.\nREBOOT 
MOBILE UNIT; 

Have been trying to contact the 
host for the radio timeout period (2 
minutes default). 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

REBOOT MOBILE UNIT; Reboot the Mobile Unit do to loss 
of connection. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Retry (Y/N)?; Try again. Try to send or receive again, or 
perhaps ensure that the printer is 
cabled to the Mobile Unit and is on. 
 

--- 
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Message Reason Solution Reference Tech Note 
    

TIMEOUT\n\nSending Data; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

TIMEOUT\n\nReceiving Data; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Host Received Data\nAwaiting App 
Reply!; 

Mobile Unit has sent and received 
an acknowledgement from the IP 
stack and is waiting for the 
application to return data. 

Most likely a host or network issue. 
Troubleshoot the customer’s 
environment. Probable causes are 
Database record locking, application 
program failure, Host failure or 
network failure. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

* WAITING TO SEND  *; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

TCP Error Reading\nMAC 
Address.\nREBOOT MOBILE UNIT; 

Could not obtain the Mac Address 
from the Mobile Unit. 

Possible hardware, driver or stack 
problem Contact the Mobile Unit 
manufacturer. 

--- 

Invalid TIP Command; Bad internal protocol. Notify Connect over the WEB incident 
reporting system. 

--- 

Session Ended\nBy User or Host; User, Host, application or network 
has ended the session. 

If the user did not end the session, 
most likely host or network issues. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Server Packet Error; Bad Protocol detected. Usually a result of bad cabling, power 
or faulty transceiver. Also, will receive 
this if the Mobile Unit is in the wrong 
mode for server operation. 

--- 
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Message Reason Solution Reference Tech Note 
    

Error receiving host\nlist from Server; Bad Protocol detected. Usually a result of bad cabling, power 
or faulty transceiver. Also, will receive 
this if the Mobile Unit is in the wrong 
mode for server operation. 

--- 

Unexpected Server\ndata received; Bad Protocol detected. Usually a result of bad cabling, power 
or faulty transceiver. Also, will receive 
this if the Mobile Unit is in the wrong 
mode for server operation. 

--- 

Error starting\nhost application; Connected to the server but cannot 
connect to the distant end. 

Configure the server handler to access 
the host application. 

--- 

Select Host or App; Need to choose your 
Host/application destination. 

User selection required. --- 

Connecting...; Attempting to connect to the 
Host/application. 

Advisory message. --- 

TCP Error\nReading IP 
Address\nREBOOT MOBILE UNIT; 

Mobile Unit missing Network IP 
information. 

Configure the Mobile Unit with the 
correct network IP information. 

--- 

Printer start error; Could not initialize the printer. 
 
 

Cable or power issue with the printer. --- 

Battery too low\nto print; Not enough power to print. Replace the battery with a fully 
recharged battery. 
 

--- 

Paper Feed Error\nFix Then Hit Enter; Paper in the printer is not ready. Replace the paper or rethread the 
paper in the printer. 
 

--- 

Printer Error\nPrint Ended; Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 
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Message Reason Solution Reference Tech Note 
    

User Count Exceeded.\n Session 
Ended;  

Possible authorization issue. Verify that you have the correct 
number of licenses for the number of 
Mobile Units you are using. 
 

--- 

Primary Unavailable\nTrying Alternate; First Host IP address not available 
trying the remaining addresses in 
the Host list. 

Verify the host address. --- 

APMAC.DAT Error\nSession Ended; Access point Media Access Control 
error. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

MUIP.DAT Error\nSession Ended;  Mobile Unit IP Error. Most likely a Mobile Unit network 
setting issue. Troubleshoot the 
customer’s environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Missing Subnet IP\nSession Ended;  Mobile Unit IP Netmask Error. Most likely a Mobile Unit network 
setting issue. Troubleshoot the 
customer’s environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Error Opening File;  File is missing. Verify that the configuration files are 
on the Mobile Unit.  Or perhaps there 
is a hardware failure. 

--- 

Telnet API\nnot found; Program files are missing. Reload program files. --- 

Battery Low Warning\n\nReplace 
Battery Soon;  

Not enough power to operate the 
Mobile Unit. 

Replace the battery with a fully 
recharged battery. 

--- 

No Host List.\nPress any key\nTo Edit 
Host IP's;  

Have not configured your target 
hosts. 

Configure the target host IP 
addresses. 

--- 

Unable to Allocate\nFont Memory; Mobile Unit does not have enough 
memory to load the fonts. 

Reduce the fonts in use or expand the 
memory in the Mobile Unit. 

--- 
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Font Loading Error; Could not load the font. 
 
 

Ensure that the font is available to 
load. 

--- 

Printer Not Ready\nPress R to Retry\nC 
to Cancel Print; 

Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

Mobile Unit in\nDemonstration 
Mode\nfor Twin Client;  

Running in demo mode. Purchase a license from Connect. --- 

Connected to Host;  Successful connection to the target 
Host. 

Advisory message. --- 

Telnet Mode not\nsupported on\nthis 
Mobile Unit;  

This Mobile Unit must be used with 
a Connect Server. 

Order a Connect Server. --- 

Telnet Setup files\nnot found. 
Reload\nfiles then switch;  

Customer specific configuration 
files are missing. 

Load the configuration files into the 
Mobile Unit from Twin Client Manager.

--- 

Switched Client to\nTelnet Direct Mode; Mobile Unit running in Telnet mode 
direct to the target Host. 
 

Advisory message. --- 

Switched Client to\nServer Based 
Mode;  

Mobile Unit running through a 
Connect server in Server mode 
usually at port 1800. 

Advisory message. --- 

Port 23 is only\nallowed in Telnet 
Mode;  

Can not set the port to 23 in Server 
mode.  Port 23 is the standard 
Telnet port. 

Advisory message. --- 

Not Enough Memory\nTo Run; Mobile Unit does not have the 
capacity to run the program do to 
memory restrictions. 

Expand the Mobile Unit memory. --- 

Press any key; Press a key to continue. Advisory message. ---
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Twin Client Telnet;  Prompt. Advisory message. --- 

Twin Client Server;  Prompt. Advisory message. --- 

Twin Client TN3270; Prompt. Advisory message. --- 

Twin Client TN5250; Prompt. Advisory message. --- 

Twin Client TNVT; Prompt. Advisory message. --- 

(c) 1991-2006 Connect; Prompt. Advisory message. --- 

Edit Menu Options; Menu Title. Advisory message. --- 

Edit Mobile Unit IP; Menu Option. Advisory message. --- 

Edit Server/Host IPs; Menu Option. Advisory message. --- 

Edit Radio Option; Menu Option. Advisory message. --- 
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Edit License Key;  Menu Option. Advisory message. --- 

Run Site Survey;  Menu Option. Advisory message. --- 

Switch Client Modes; Menu Option. Advisory message. --- 

Run Twin Client; Menu Option. Advisory message. --- 

Exit to OS;  Menu Option. Advisory message. --- 

Printer may not be\nplugged in 
or\nturned on!; 

Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

OUT OF RANGE OF BASE; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

CONNECT SERIAL CABLE; Serial cable not connected to the 
Mobile Unit. 

Check cable, battery and 
communication settings for the Mobile 
Unit. 

--- 

REMOVE SERIAL CABLE; Remove serial cable from to the 
Mobile Unit. 

Check cable, battery and 
communication settings for the Mobile 
Unit. 

--- 

PLACE IN CRADLE; Place the Mobile Unit in the cradle. Advisory message. --- 
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REMOVE FROM CRADLE; Remove Mobile Unit from the 
cradle. 

Advisory message. --- 

ACQUIRING CRADLE BUS;  Attempting to access the cradle 
through the serial port you have 
configured. 

Advisory message. --- 

Printer Out\nOf Range; Printer out of the coverage area. Most likely a range, access point or 
radio issue. Troubleshoot the 
customer’s environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Refused\nBy Host; You connected to the target host 
but the host disconnected you. 

Verify that the configuration file has 
the correct Mobile Unit type and New 
environment variable set.  Fallback to 
the Connect Default to verify the 
connection. 

--- 

Connection Timed Out; You connected to the host but did 
not logon in the appropriate time so 
the host disconnected you. 

Modify the Host parameters for login. --- 

Connection Failed\nHost Not 
Responding; 

Could not connect to the Host. Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Failed\nHost Unreachable; Could not connect to the Host. Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Out\nOf Range, 
Unable\nTo Transmit; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

4-10  Supported Equipment Manual   •   May, 2006 



   Error Message Resolution Guide 

 

Message Reason Solution Reference Tech Note 
    

Mobile Unit Out\nOf Range, 
Unable\nTo Receive; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

--- 

Printer Not\nResponding; Can not print. Check cable, battery, communication 
settings and paper in the printer. 
 
 

--- 

Printer Out\nOf Range; Printer out of the coverage area. Most likely a range, access point or 
radio issue. Troubleshoot the 
customer’s environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Print Complete; Prompt. Advisory message. --- 

Reprint (Y/N)?; Yes or No prompt for a reprint. Advisory message. --- 

WARNING;  Prompt. Advisory message. --- 

Turning power off\nduring a 
session\nwill cause the\nprogram to 
restart; 

This Mobile Unit will disconnect the 
session if powered off. 

Mobile Unit manufacturer limitation. 
Advisory message. 

--- 

Are you sure (y/n)?; Yes or No prompt for a 
confirmation. 

Advisory message. --- 

You Sure? (YyNn); Yes or No prompt for a 
confirmation. 

Advisory message. --- 
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Domain Name Server\nNot Set; DOMAIN NAME SERVER not 
configured. 

Configure the Mobile Unit with the 
correct network IP information. 

--- 

Domain Name Server\nQuery Memory 
Error; 

Memory error on the Mobile Unit Expand the Mobile Unit memory or 
return the Mobile Unit for repair. 

--- 

Domain Name Server\nQuery Sending 
Error; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Domain Name Server\nQuery Receive 
Error;  

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Domain Name Server\nUnavailable; Could not connect to the DOMAIN 
NAME SERVER. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Error loading\nparameter file; Could not load the parameter file. Reload the correct configuration files. --- 

Could not open\ntelnet interface; Could not Telnet. Reload the program files. --- 

Could not set\mtelnet options; Could not use the Telnet 
configuration. 

Reload the correct configuration files. --- 

Setup file\nsetting mismatch\nReload 
Setup; 

Emulation program selected is not 
compatible with the configuration 
file on the Mobile Unit. 

Remove the emulation and 
configuration files. Run clear Telnet on 
the Mobile Unit then reload the Mobile 
Unit with the proper emulation and 
configuration files. 

--- 
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Display formatting\ntoo large 
for\ncurrent screen; 

Mobile Unit does not have enough 
memory to run your configured 
reformatted screens. 

Expand the Mobile Unit memory or 
order a server from Connect. 

--- 

Mobile Unit\ninitialization error; Mobile Unit problem. Return the Mobile Unit to the 
manufacturer for repair. 

--- 

Host/App/Network\nclosed the session; Customer’s environment 
disconnected the Mobile Unit 
session. 

Most likely a range, access point, 
radio, host or network issue. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Disconnecting...;   Prompt. Advisory message. ---

Scan Barcode; Bar code scanning test. Advisory message. --- 

Enter Setup\nPassword;  Prompt. Advisory message. --- 

Enter Profile \nPassword; Prompt. Advisory message. ---

Host IP; Host IP address prompt. Enter target host IP address. --- 

Host Name; Host name prompt. Enter target host Name. --- 

Port; Host IP port required. Enter 23 for Telnet or 1800 for a 
Connect server. Could also be a 
different number depending on the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 
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Mobile Unit Type;  Prompt. Advisory message. --- 

WARNING: This will \nend any\ncurrent 
session; 

Prompt. Advisory message. ---

Continue (Y/N)?; Prompt. Advisory message. --- 

HOST ENTRY; Prompt. Advisory message. --- 

VT(100/220) Setup; Prompt. Advisory message. --- 

Mobile Unit Info; Prompt. Advisory message. --- 

Emulation Setup; Prompt. Advisory message. --- 

ANSI Setup; Prompt. Advisory message. --- 

Miscellaneous Setup; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 
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Control Codes; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 

<BK SP> Sends; Prompt. Advisory message. --- 

New Line Mode; Prompt. Advisory message. --- 

Insert Mode; Prompt. Advisory message. --- 

Autowrap Mode; Prompt. Advisory message. --- 

Cursor; Prompt. Advisory message. ---

EMULATION SETUP; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 
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Map Underline; Prompt. Advisory message. --- 

Break Key; Prompt. Advisory message. --- 

ANSI Setup; Prompt. Advisory message. --- 

Control Codes; Prompt. Advisory message. --- 

Backspace Key; Prompt. Advisory message. --- 

MISCELLANEOUS SETUP; Prompt. Advisory message. --- 

Test Options; Prompt. Advisory message. --- 

Login Options; Prompt. Advisory message. --- 

TEST OPTIONS; Prompt. Advisory message. --- 

Printer Test; Prompt. Advisory message. --- 
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Scan Code Test; Prompt. Advisory message. --- 

LOGIN OPTIONS; Prompt. Advisory message. --- 

User Name; Prompt. Advisory message. --- 

User Password;  Prompt. Advisory message. --- 

ON; Prompt. Advisory message. ---

OFF; Prompt. Advisory message. ---

Map; Prompt. Advisory message. ---

Don't Map; Prompt. Advisory message. --- 

Enable Break; Prompt. Advisory message. --- 

Disable Break; Prompt. Advisory message. --- 
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7 bit; Prompt. Advisory message. --- 

8 bit; Prompt. Advisory message. --- 

Send Delete; Prompt. Advisory message. --- 

Send Backspace;  Prompt. Advisory message. --- 

Mobile Unit Setup; Prompt. Advisory message. --- 

Scanner Options; Prompt. Advisory message. --- 

Program Options; Prompt. Advisory message. --- 

Special Options;  Prompt. Advisory message. --- 

Beeper Options;  Prompt. Advisory message. --- 

Exit to DOS; Prompt. Advisory message. --- 
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Backlight Time; Prompt. Advisory message. --- 

Enter Key Action; Prompt. Advisory message. --- 

Reset Options; Prompt. Advisory message. --- 

Font Size;  Prompt. Advisory message. --- 

Portable Printer; Prompt. Advisory message. --- 

Reprint Option; Prompt. Advisory message. --- 

Data IDs; Prompt. Advisory message. --- 

Internal/External; Prompt. Advisory message. ---

Modify Beeps; Prompt. Advisory message. --- 

Message Beeps;  Prompt. Advisory message. --- 

Supported Equipment Manual   •   May, 2006  4-19  



Error Message Resolution Guide 

 

Message Reason Solution Reference Tech Note 
    

     

     

Scan Identifier; Prompt. Advisory message. --- 

AID Scan Setup; Prompt. Advisory message. --- 

Long Scans; Prompt. Advisory message. --- 

Scan Send;  Prompt. Advisory message. --- 

Yes; Prompt. Advisory message. ---

No;  Prompt. Advisory message. --- 

Normal; Prompt. Advisory message. ---

Double Wide; Prompt. Advisory message. --- 

Double High; Prompt. Advisory message. --- 

Double High and Wide; Prompt. Advisory message. --- 
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Errors Only; Prompt. Advisory message. --- 

Automatic; Prompt. Advisory message. ---

All Messages;  Prompt. Advisory message. --- 

Reject; Prompt. Advisory message. ---

Truncate; Prompt. Advisory message. ---

Split;  Prompt. Advisory message. --- 

Do Not Send; Prompt. Advisory message. --- 

Always Send; Prompt. Advisory message. --- 

Last Field Only; Prompt. Advisory message. --- 

Internal; Prompt. Advisory message. ---
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External; Prompt. Advisory message. ---

none; Prompt. Advisory message. ---

monarch; Prompt. Advisory message. ---

pddumb; Prompt. Advisory message. ---

comtec; Prompt. Advisory message. ---

rascal; Prompt. Advisory message. ---

codewriter; Prompt. Advisory message. ---

comtec(S); Prompt. Advisory message. ---

User Name; Prompt. Advisory message. --- 

Password;  Prompt. Advisory message. --- 
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Frequency:      Hz; Prompt. Advisory message. ---

Duration:       ms; Prompt. Advisory message. --- 

Delay:          ms;  Prompt. Advisory message. --- 

Select Scanner; Prompt. Advisory message. --- 

Setup Scanner; Prompt. Advisory message. --- 

Scan Test; Prompt. Advisory message. --- 

Scan Operation;  Prompt. Advisory message. --- 

Laser; Prompt. Advisory message. ---

Contact/Pulse; Prompt. Advisory message. ---

Contact/No Pulse; Prompt. Advisory message. --- 
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Auto/Pulse; Prompt. Advisory message. ---

Auto/No Pulse; Prompt. Advisory message. --- 

Wand Simulation;  Prompt. Advisory message. --- 

VT100; Prompt. Advisory message. ---

VT220; Prompt. Advisory message. ---

SETUP; Prompt. Advisory message. ---

Mobile Unit IP/Radio; Prompt. Advisory message. --- 

Host List; Prompt. Advisory message. --- 

NULL; Prompt. Advisory message. ---
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